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The introduction of cloud technologies in the educational process is a priority for domestic 
education. The selection of appropriate services that can be used to improve the educational 
process remains a key issue in solving these problems. The authors note the possibility of using 
cloud services in all areas of education and emphasize the availability of online set of tools for 
processing graphics files, which provides users with corresponding software for creating and 
designing graphics files, provision of server storage space, as well as access to all saved assets 
at any time from any device with Internet access. The article describes the experience of using 
cloud services in the educational process of training computer science teachers of Zhytomyr Ivan 
Franko State University, in particular the online graphic editor Pixlr. Peculiarities of settings and 
functionality of this software product are described. A detailed description of the cloud service is 
given and a comparison is made with the most typical software products used to create computer 
graphics, illustrated with examples and screenshots. The use of the Pixlr Editor cloud service to 
solve one of the most common image processing issues, namely tone adjustment, is considered. 
Also, the authors mentioned the negative aspects of using cloud services. Further perspectives of 
researches are outlined. 
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ВИКОРИСТАННЯ ХМАРНОГО ГРАФІЧНОГО РЕДАКТОРА PIXLR В КУРСІ 
ПРОФЕСІЙНОЇ ПІДГОТОВКИ ВЧИТЕЛЯ ІНФОРМАТИКИ 

О. М. Кривонос, С. С. Жуковський, М. П. Кривонос 

Впровадження хмарних технологій в освітній процес є пріоритетним завданням для 
вітчизняної освіти. Добір відповідних сервісів, на основі використання яких можна 
поліпшити освітній процес, залишається ключовим питанням в розв’язанні даних 
проблем. Автори статті зазначають про можливість використання хмарних сервісів в 
усіх сферах діяльності навчального закладу, та акцент роблять на використання онлайн-
додатку для опрацювання графічних файлів, який надають користувачам програмне 
забезпечення для створення та оформлення графічних файлів, місце на сервері системи 
для їх зберігання, а також доступ до них у будь-який момент часу з будь-якого пристрою 
при наявності виходу в інтернет. В статті описано досвід використання в навчальному 
процесі підготовки вчителів інформатики Житомирського державного університету імені 
Івана Франка хмарних сервісів, зокрема онлайн графічного редактора Pixlr. Описано 
особливості налаштування та функціонал даного програмного продукту. Зроблено 
детальний опис хмарного сервісу та проведено порівняння з найбільш типовими 
програмними продуктами, що використовується для створення комп’ютерної графіки, 
проілюстровано прикладами та скріншотами. Розглянуто застосування хмарного сервісу 
Pixlr Editor для розв’язування однієї із найтиповіших задач стосовно опрацювання 
зображень – тонового коригування. Також, автори статті зазначели негативні сторони 
використання хмарних сервісів. Окреслено подальші напрями досліджень. 

 
Ключові слова: програмне забезпечення, хмарні сервіси, тонове коригування 

зображення, Pixlr, тоновий діапазон. 
 
Introduction of the issue. The rapid 

development of information and 
communication technologies (ICTs), as 
well as the emergence of new electronic 
devices, including the improvement of 
application software, contribute to the 
improvement of educational 
technologies. However, taking into 
consideration current conditions, it is 
necessary to constantly devote time to 
software and hardware maintenance, 
purchase and installation of up-to-date 
applications, upgrade of the existing 
equipment. Unfortunately, higher 
education institutions can’t always offer 
suitably qualified service staff and 
adequate funding, moreover, it is not 
also always possible to ensure the 
appropriate mobility of the software in 
the learning process (the ability to 
install and use a particular software 
product on any desktop computer). Use 
of cloud technologies in the educational 

process is a way to solve the above-
mentioned issues, for with the 
combination of modern ICTs and high-
speed broadband Internet connection 
most services can be transferred to the 
cloud, where the most data-related 
operations are processed. According to 
the National Institute of Standards and 
Technology (NIST), cloud computing 
[10] is a model for providing ubiquitous, 
convenient on-demand network access 
to computing resources (such as 
networks, servers, storage systems, 
applications, and services) that can be 
provided quickly and flexibly with 
minimal effort and interaction with the 
service provider. Therefore, almost all 
software developers try to provide their 
users with an online version of their 
software products. 

Current state of the issue. 
Possibilities of using cloud services in 
the initial process and in scientific work 
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were investigated by V.Yu. Bykov [1], 
T.A. Vakaliuk [2], M.I. Zhaldak [3], 
O.O. Hrybiuk, S.H. Lytvynova [4], 
N.V. Morze [5], Yu.H. Nosenko [6], 
S.O. Semerikov [7], O.M. Spirin [8], 
Yu.V. Tryus [9], M.P. Shyshkina [10] 
and other [11, 12].  

In "The NIST Definition of Cloud 
Computing" the authors define cloud 
technologies as a model for providing 
network access to a shared array of 
computing resources of variable 
configuration (servers, storage systems, 
services, or/and applications) in any 
convenient location that can be 
provided instantly with minimal 
management efforts and interaction 
with the service provider [13]. A 
distinctive feature of cloud technologies 
is granting fast service delivery and 
access to resources at any time in any 
user-friendly and convenient 
environment. 

Thus, currently there are three main 
types of cloud services: SaaS (software 
as a service), PaaS (platform as a 
service), IaaS (infrastructure as a 
service). SaaS, as one of the most 
popular entities, is a software 
deployment model that involves 
providing software directly to the user 
as an on-demand service through the 
use of an Internet browser. The main 
end-user advantage of such distribution 
is the absence of necessity of 
installation/uninstallation, 
troubleshooting, update of the software 
and/or maintenance of local hardware. 
Most services support simultaneous 
multiuser interaction with the file. 

One of the main trends in education 
today is informatization and 
computerization, which imply the 
introduction of new information 
technologies in the educational process, 
equipping educational institutions with 
computers, as well as broadband stable 
access to the Internet. These processes 
formed a new scientific and technical 
base for the formation and development 
of new forms of educational activities, 
which led to the emergence of virtual 

educational institutions operating on 
the Internet. Creating a virtual 
educational environment is a solution 
to one of the tasks of pedagogy, namely 
the development of effective forms of 
organization of the educational process. 
The basis of information systems that 
provide the virtual environment of the 
educational institution are different 
approaches, methods and tools, but the 
most effective is the use of cloud 
technologies, which are a promising 
area that opens up huge benefits and 
perspectives in the sphere of data 
management. 

Cloud computing is a model of 
providing ubiquitous and convenient 
on-demand network access to a 
common pool of configurable computing 
resources (e.g. data networks, servers, 
storage devices, applications, services 
(together and separately)) that can be 
effectively used with minimal operating 
costs or necessity to contact the 
provider. 

Compared to traditional 
technologies, cloud computing has a 
number of significant advantages, such 
as: affordability, mobility, flexibility, 
reliability, high level of sophistication, 
rental and cost-effectiveness, thanks to 
which they are widely used in many 
fields of science and technology. 

Today, cloud technologies are used 
in various fields of human activity: 
banking, medicine, business, including 
education. Thus, educational cloud 
services are used not only in distance 
learning, but also in traditional 
educator-student face-to-face 
interaction forms, for they provide a 
number of opportunities, such as the 
creation of virtual laboratories on the 
Internet, Internet conferences and 
webinars, management of various 
processes of the virtual environment of 
the university, which is identified as a 
digital entity that aims not only to 
support distance learning, but also to 
manage and optimize the business 
processes of the university. 
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Modern information and educational 
environment of the university is 
analyzed in the context of digital 
manifestation of various aspects and 
fragments of the university on the 
Internet. There are different design 
patterns of e-learning environment that 
take into account the interests, likes 
and dislikes of different groups of 
network users. From the socio-
psychological standpoint, the role of the 
digitalized educational environment of 
the university in the improvement of 
educational technologies includes the 
emergence of new aspects of teaching, 
as well as the conditions of self-
realization of students. 

However, cloud technologies can 
become not only the basis of distance 
learning, but also provide continuous 
support for improving real-life 
interaction-based education. The 
educational institutions have a set of 
tools and mechanisms with well-
established algorithms of interaction: 
the educational process is closely 
intertwined with the processes of 
accounting, personnel accounting, 
contractual relations. Therefore, we 
should consider cloud computing as a 
means of consolidating various internal 
subsystems and creating a virtual 
environment that will ensure the 
interaction not only of teachers and 
students, but will make the following 
features available:  

• publication of announcements, 
news, including announcements of 
important events; 

• exchange of electronic messages 
between users, centrally or in separate 
categories; 

• organization of scientific 
conferences, seminars, including 
Internet events and webinars; 

• remote interaction with students, 
including the provision of electronic 
teaching materials, online 
consultations, testing, digital schedule;  

• electronic interaction with 
applicants, including information 

provision, consultations, remote 
registration of applicants. 

Today, the online applications for 
creating presentations and related 
materials are becoming more 
widespread, which provide users with 
corresponding software, server store 
space, as well as access to them at any 
time from any device with internet 
access. It is also possible to publish 
already created works, view and use 
presentations of other users (if 
published for free access). 

Summarizing the above-mentioned, 
it should be noted that the use of cloud 
technologies in the educational process 
will allow educational institutions to 
significantly reduce costs, as well as 
increase the efficiency of computing 
resources. In this case, access to 
information stored on the cloud server 
can be obtained by any user who has a 
computer or mobile device connected to 
the Internet. In addition, the use of 
cloud technology will reduce the staff of 
maintenance personnel, as well as 
eliminate the need to involve third-
party programmers and IT 
professionals. 

Let’s review a free cloud service for 
working with bitmap graphics – online 
graphic editor Pixlr. 

Aim of research is to analyze online 
graphic editor Pixlr and peculiarities of 
its use in the process of computer 
science teachers’ professional training. 

The research was conducted within 
the framework of R&D (research and 
development works) "Use of modern 
information technologies (ITs) in 
education and science" of the 
Department of Applied Mathematics of 
Zhytomyr Ivan Franko state university.  

Research Methods. During the 
research the following methods were 
used: analysis of psychological-
pedagogical, scientific-technical 
literature on the issues of introduction 
of ITs in the education; modeling the 
functioning of web services of 
information-educational space; method 
of parallel experiment.  
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Thanks to the wide availability of 
affordable scanners and high-quality 
digital cameras in smartphones, 
computer graphics have taken one of 
the leading positions in the life of a 
modern individual. Thus, even amateur 
picture processing requires certain 
knowledge and skills related to the 
creation of graphic objects using a 
personal computer (PC), as well as 
application of post-effects. 

Currently, there are several online 
raster graphic editors: 2IP, Aviary, 
Befunky, Pixlr, Canva, Figma, Fotor, 
Sumo Paint, Splashup, PicMonkey and 
others. All of them feature convenient 
and user-friendly interface, a standard 
set of tools for processing photos and 
digitalized drawings, as well as 
functionality for creating collages, etc.  

Pixlr is a cloud service by Autodesk 
software developer, which provides 

almost complete functionality of the 
original Adobe Photoshop CC. Pixlr has 
a variety of features and a user-friendly 
localized (fully translated into 28 
languages, including Ukrainian) 
interface with clear description of every 
available graphic instrument. The 
service can be used for processing HD 
(high definition and resolution) images, 
including altering curves and layers of 
the picture with a documented history 
of user actions, as well as the 
possibility to use a number of filters. 
Thus, this cloud service requires 
reliable Internet connection and the 
latest version of the compactible 
browser. 

When you first start the cloud 
service, a dialog box appears (fig. 1), in 
which you are asked to choose from two 
editor options: Pixlr E (for advanced 
users) and Pixlr X (for beginners). 

 

 
Fig. 1. Рixlr startup dialog box. 

 
Let’s review the functionality of Pixlr 

E. In the left part of the screen there is 
a start menu of the editor which 
contains the following options: history; 
create new; stock search; open existing 
photo; download from URL. Thus, we 
press the 4th button and upload an 
existing photo. The image from the file 
itself opens in a small window in the 
central part of the screen; it can be 
resized by using mouse scrolling. On 

the left side of the screen is the Tools 
panel, which allows to perform a series 
of image-related actions, such as 
merge, trim, resize, retouch, reduce or 
increase contrast, and more. Moreover, 
the following functions can be used to 
alter the file: cut, separate, move, lasso, 
magic wand, pencil, brush, eraser, fill, 
gradient, stamp-clone, color change, 
draw, blur, contrast, finger, sponge, 
magic tool, "scratch", remove "red eyes" 
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effect, heat, convexity, concavity, choose 
color, hand, text, scale, user palette. 
There are three windows on the right 
side of the screen. "Navigator" is a 
window in which you can use the 
cursor to zoom in/out (percentage-
based); the "Layers" window is used to 
work with image layers: styles, masks, 
and setting switches; the "History" UI 
displays the latest changes applied to 
the image - the last 15 steps are saved 
by default and can be cancelled by the 
user. At the top of the screen is located 
the main menu of the program, which 
contains the following list of options: 
file, edit, image, layer, select, correction, 
filter, view, help. Let's analyze these 
nine items: 

1. The menu item "File" contains the 
following sub-items: new image, open 
image, open image URL, open library, 
view items, save, print, close. 

2. The menu item "Edit" includes 
such commands as: cancel, repeat, cut, 
copy, clear, paste, arbitrary 
transformation, change, contour, fill, 
preferences. 

3. The "Image" menu item combines 
such editing tools as: image size, 
canvas size, rotate the canvas 180°, 
rotate the canvas 90° clockwise, rotate 
the canvas 90° counterclockwise, 
display the canvas vertically, display 
canvas horizontally; it also includes 
basic options: bend, trim and restore. 

4. The "Layer" menu item includes 
tools for editing layers, including: new 
layer, duplicate layer, delete layer, open 
image as layer, open image URL as 
layer, open libraries as layer, merge, 
merge visible objects, merge image, 

move layer up, move layer down, layer 
style, rasterize layer, add layer mask, 
remove layer mask, apply layer mask, 
rotate layer 180°, rotate layer 90° 
clockwise, rotate layer 90° 
counterclockwise arrows, display layer 
vertically, display layer horizontally. 

5. The following commands are 
included in the "Select" menu item: 
select all; select the peak of the village, 
cancel the selection; inversion of the 
selected; conversion to mask; save 
selected; restore selected. 

6. The menu item "Correction" 
includes the following: autocorrection, 
brightness and contrast, temperature 
and hue, tone and saturation, 
juiciness, color balance, color search, 
glare and shadows, exposure, curves, 
levels, threshold, pasteurization, 
discoloration, color inversion. 

7. The menu item "Filter" includes 
such sub-items: library of effects, 
details (sharpness, transparency, 
blurring, Gaussian blur, blur zoom, 
smoothing, graininess, sharpen, add 
noise, remove noise), vignette, bloom, 
glamor, remove fog, internal radiance, 
external radiance, contour, remove 
shadow, side light, titleSobel, variance, 
titleScanlines, pixelation, mosaic, 
halftone. 

8. The "View" menu item combines 
the commands: enlarge, reduce, screen 
size, full screen, zoom (100 %, 200 %, 
300 %), full screen mode, dark or light 
modes. 

9. The "Help" section contains 
information about hotkeys and links to 
community pages on social networks. 
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Fig. 2. Pixlr Х startup dialog box. 

 
The editor offers a light version of the 

product – Pixlr X, which includes only 
basic image processing tools and 
functionality (fig. 2), the startup dialog 

box displays the following options: 
history, create new, stock search, open 
image or download from the Internet 
(URL picture). 

 
Fig. 3. An example of using one of the effects in Pixlr X. 

 
Pixlr X provides modern tools for deep 

photo editing; it supports most image 
types and formats, such as: PSD 
(Photoshop), PXD, JPEG, PNG; this 
software complex is ideal for quick photo 
editing and adding sophisticated effects 
with one mouse click, namely: resizing 
the canvas or the image itself, cropping, 
removing extra elements, changing the 
brightness, saturation in the growth 
layers, applying filters and effects (12 

main groups of effects), retouching, 
adding elements, and so on. 

As an example, we’ll consider the use 
of the Pixlr E cloud service to perform 
one of the most common image 
processing tasks – tone adjustment. 
Let's explain the essence of the process 
in more detail: the key difference 
between quality photos is the correct 
distribution of light and shadows. In 
this case, the objects in the image look 
embossed and well perceived by the 
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human eye. However, the vast majority 
of pictures taken by non-professional 
photographers are characterized by 
defects in lighting, shadow distribution 
and image contrast. In general, they 
can be combined with the phrase "tone 
image defects", and the process of 
correcting them – tone adjustment. 

The tone of a digital image is the 
brightness of the pixels that make it up, 
while part of the range used in the 
image is called the "tone range" [14]. 

Among the whole list of tools 
designed for editing digital photos in 
the Pixlr cloud environment, two 
important "Correction" menu 
commands should be singled out: 
"Levels" and "Curves". These tools are 
similar to those included in desktop 
and laptop software applications such 
as Adobe Photoshop CC, GIMP and are 
designed to perform similar operations: 
redistribution of shadows and light in 
the image.  

Let’s review them in more detail. The 
"Levels" toolkit is used to alter the 
tonal range by adjusting the intensity 
levels of shadows, halftones, and light 
tones of the image. Picture 3 shows the 
view of its UI window in the cloud 
service Pixlr, however, the window itself 
is divided into the following parts:  

- Window’s title;  
- Color channel selection field; 
- Image tone-based pixels’ quantity 

distribution histogram field 
(distribution occurs in the range from 0 
to 255, where 0 corresponds to value of 
black, and 255 – white);  

- Image tone correction results;  
- Apply and cancel changes 

buttons.  
A key feature of the tool is the ability 

to specify which tone of the original 
image will correspond to a completely 
dark or light (white) point on it, as well 
as to pinpoint a correct place for 
penumbra. The result of applying the 
corresponding enhancements will be an 
increase in the contrast of the picture, 
thus improving the clarity of small 
details, as well as the removal of 
grayish tone. It is possible to edit each 
color channel separately, which adds 
more opportunities for image 
decoration. The "Curves" tool is more 
flexible than "Levels" command, its 
settings are shown in figure 5.  

The toolbox UI window contain:  
1. Window title. 
2. Color channel selection field. 
3. Color curve edit field. 
4. Apply and cancel changes 

buttons. 

  
Fig. 4. "Levels" toolkit UI window. Fig. 5. "Curves" toolkit UI window. 
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Curve editing field is the key element 

of the interface. It is divided into 16 
squares (4x4). The underside of the 
square corresponds to the original 
image, namely its tonal distribution. At 
the same time, the left side is the result 
of processing using certain algorithms 
in accordance with the specified 
settings. It is important to point out 
such features of the field itself. Editing 
the curve in the upper right square 
allows to change the redistribution of 
pixels in the light part of the range of 
tones. Instead, the lower left square is 
used to represent shadows. The four 
central squares are a conditional 
representation of the semitones. The 
essence of the "Curves" toolkit is that 
when it is used, it can not only narrow 
the tonal range, but also edit it in 
certain areas. Based on the mentioned 
overview of both the general 
possibilities of using Pixlr and its tone 
adjustment tools, we will reveal the 
techniques of tone editing of images in 
this cloud service. Download the image 
and at the first stage use the "Levels" 
toolkit from the "Adjustment" menu. 
Let's analyze the obtained histogram: 
here’s the case when the photo has no 
pixels in the shadows and light part of 
the tone range. In order to overcome 
these defects, it is necessary to move 
the appropriate markers, so that the 
shadow marker should be placed at the 
base of the darkest real point of the 
photo, the white marker – at the 
corresponding base of the brightest 
point. The halftone marker must be 
shifted to illuminate the picture. The 
performed manipulations indicate that 
the darkest point of the image will 
correspond to the actual tone of the 
image from the position of shadows, 
and the lightest point – the brightest 
tones. In fact, the tonal range is 
stretched. In the second stage, we will 
use the "Curves" toolkit, which is a 
much more effective tool. In most cases, 
an "S-shaped" curve is used to preserve 
bright colors. In particular, it should be 

noted that there are modifications in 
the field of shadows and light. Dark 
pixels were more shaded and light ones 
were lightened. 

Conclusions and research 
perspectives. In general, tone 
correction is not limited to the use of 
only above-mentioned tools, but for 
most cases, joining them allows to edit 
photos on the basic level. Moreover, the 
toolkits of the Pixlr cloud service are 
quite similar to the ones of the most 
popular software solutions, such as 
Adobe Photoshop. UI similarity can be 
used for educational purposes in the 
training of pupils and students, 
including the specialty "Computer 
Science". In fact, the combination of 
accessibility, the use of services in an 
average browser window, and 
functionality that is not inferior to the 
leading software for creating and 
editing images, makes it an important 
subject for studying the features of 
modern computer graphics. Thus, 
cloud technology is one of the areas 
that is developing extremely fast, as 
evidenced by the activity of such 
companies as Intel, Adobe and 
Autodesk. Therefore, the prospects for 
the study of relevant graphics services 
in school and in higher education 
institutions justify the prospects for our 
further research, which implies 
development of appropriate methods of 
teaching CS-based disciplines. 

However, it is important to mention a 
number of problems of cloud 
technologies, namely data protection 
and security. Most connections to/from 
cloud service are encrypted in order to 
preserve confidentiality of customer 
data. However, some services don’t 
guarantee the total safety of uploaded 
files, for a possibility of the user data to 
be viewed by unauthorized entities 
remains a serious issue. Moreover, 
some companies enforce obligatory 
moderation of the data uploaded, which 
compromises confidentiality even more. 
Another disadvantage of cloud 
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technology is that to work with cloud 
services you need a stable Internet 
connection. 

Despite the above-mentioned 
shortcomings of cloud technologies, 
their application in various fields, 
including education, still remains a 
topical issue. Cloud computing services 
offer great opportunities for learners 
and teachers, as well as for developers 
of resources and subsystems that are 
directly related to education or 
accompany the educational process. 

Currently, an important challenge is 
to maximize use of cloud technologies 
and improve the quality of modern 
education without compromising 
existing effective teaching methods and 
tools. 
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